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Introduction to GIS
This exercise is designed to familiarize you with the some basic concepts and capabilities
of GIS. You will explore the abilities of ArcGIS to visualize, navigate, manipulate, and
analyze geographic datasets.
Specifically, you will learn how to:
• Create a map project
• Add layers to your project
• Display data to your specifications (e.g. colors, symbols, line weights)
• Navigate the data using the zoom, pan, and full extent tools
• Identify features and their attribute data
• Query the map based on your criteria
• Create Buffers around points
• Remove unnecessary features
In order to explore these concepts, we will use the dataset listed below to select the best
locations for community sponsored produce stands. In our imagined scenario, the City of
Berkeley has assigned you with the task of identifying lower income communities with
limited access to fresh fruits and vegetables. The City would like to identify 5 civic
buildings that are in close proximity to these neighborhoods and place weekly produce
stands on their property. Therefore, you’re final product will be a map depicting the
location of these potential sites and their service areas.

Dataset
You will be working with several data layers from different sources. Note that a layer is
comprised of several different files with the same name and different extensions. All
these files of the same name must be in a folder together for the software to read them.
BerkeleyFVMarkets.shp – shows point locations for fruit and vegetable markets
PublicSites.shp – point locations of public buildings, institutions, and churches. This
layer was created by combining three shapefiles and removing buildings on the Cal
campus.
BerkeleyLimits.shp – polygon of city boundaries
BerkeleyBlockGroups.shp – polygons containing demographic information for census
block groups
FarmersMarket.shp – point location of farmer’s markets
CountySub.shp – County subdivisions, used as a background image for your final map.

Display Data
In this section you will add layers to your map project and change their display
properties.

Add Data
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1. Open ArcMap by going to Start|All Programs|ArcGIS|ArcMap. Click OK to
create a new project.
2. In ArcMap, go to File, Add Data or Click on the Add Data button:
3. In the Add Data window, click on the Connect To Folder button:
4. Navigate to the folder with your data in it, and click OK. The folder’s contents
should appear in the window.
5. Add all of the layers to ArcMap. You can select multiple layers at once by
holding the Ctrl key.
6. Check off and on the boxes to the left of the layer name.
7. Click and drag the layers to rearrange their order.Arrange the layers in this order,
from top to bottom: BerkleyPublicSites, BerkleyFVMarkets, FarmersMarkets,
BerkeleyLimits, BerkeleyBlockGroups, CountySub.
8. Use the toggle switch (plus or minus in a box) to collapse and expand the legends.

9. Click the Save Button and name the file as LASTNAME_ESPM9_GIS1.mxd.

Layer properties
1. Change the BerkeleyLimits polygon to an outline by double clicking the colored
square beneath its name in the legend. Choose ‘Hollow’ and increase the outline
width to 2.0.
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2. Right-click on the layer: BerkeleyBlockGroups. A context menu appears – Stop
for a minute and look at the options in this context menu. This menu contains
several important options.
3. Choose Properties to open the Layer Properties. The Layer Properties dialog
appears. You can access the properties for the other layers in the same manner.
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4. Click on the General tab. You can change the names of layer here. This only
changes how the names display, but not the names of the files. We will keep the
current names.
5. Click on the Symbology tab. Click on ‘Quantities’ in the list to the left. Open the
drop-down menu for ‘Value’ and Select PERCAPITAI. These settings will assign
color to each polygon based on their per capita income. Choose the color ramps
shown below. Click ‘Apply’.

6. Change the number of classes to 6 and then click the ‘Classify’ button. Redefine
the bins for each class by dragging the breaks (blue lines circled below) to the
positions shown below or by manually entering the values in the break values
section. The values are: 14000; 20000; 25000; 35000; 50000; 85000. Click ‘OK’.
In the Layer Properties window click ‘Apply’ then click ‘OK’.
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7. Change the symbols for the other layers so that they are easily distinguishable
from the BerkleyBlockGroups. You can change the symbols for layers by
clicking on their symbol (colored rectangle under the layer name) as described in
step 1 of this section. Be sure to make your symbols colors that will stand out and
large enough to see.

Navigation
1. Explore the data using some of the navigation tools in the Toolbar:

2. Use the magnifying glass tools to draw a rectangle around an area to zoom in or to
zoom out. You can also use the buttons with four arrows to zoom in and out.
3. Click on the full extent button (the globe) to see your entire dataset.
4. Experiment with the other tools to see what they do.

Working with Attribute Data
Every spatial unit, such as a polygon, point, or pixel may be assigned several values that
are associated with relevant attributes. These values are stored in the database file (.dbf)
and may be viewed in an attribute table or using the identify tool. This section explores
attribute tables and some tools to query them.
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Attribute Tables
1. Right click on BerkeleyBlockGroups and select ‘Open Attribute Table.’
2. Explore the table. Each row corresponds to a spatial feature and each column
represents an attribute.
3. Right-click on the PERCAPITAI title and select ‘Sort Ascending.’
4. Click on the grey box at the beginning of a row. Now double click the same row.
ArcMap zooms into the feature that you have selected and highlights it on the
map.

5. Click the ‘Options’ button and click ‘Clear Selection.’
6. Right-click the title for PCI_BLACK and choose ‘Statistics.’ Use the drop-down
menu to view the bar graphs for each field

.
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7. Close the statistics window and the attribute table.
8. Go to the Selection menu at the top of the window and chose ‘Clear Selected
Features’.

Select Features
1. In the previous section, we selected features from the attributes table. You
can also select them directly on the map. Re-adjust your zoom level then
choose the Select Feature button from the Tools toolbar.
2. Click inside of a polygon. Hold the Shift key to make multiple selections.
9. Alternatively, you can also select features based on their attribute values. Click on
the Selection menu at the top of the window and choose ‘SELECT BY
ATTRIBUTES’.
10. Choose BerkeleyBlockGroups from the Layer drop-down menu. The rest of
these features function similarly to a calculator. We want ArcMap to select
features from BerkeleyBlockGroups where per capita income (PERCAPITAI) is
less than 20000 dollars. Double click on listed terms to insert them into a formula
and click on the mathematical buttons to insert these. Write the statement:
“PERCAPITAI” < 20000

11. Click OK. Leave these features selected for the following sections.
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Basic Spatial Analyses
Much of the power of GIS lies in its ability to analyze spatial data. This section
introduces simple spatial analysis tools.

Buffer
1. Open the ArcToolbox by clicking on the icon:
2. Choose Analysis Tools, Proximity and then select Buffer.

3. Use the Drop down list to select FarmersMarkets as the input. Leave the default
output.
4. Input a linear unit of 800 meters (about 0.5 miles). Leave the defaults for the other
fields and select OK.
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Repeat these steps for BerkeleyFVMarkets with the same values.

Merge
Now we can merge the FVMarkets_Buffer and FarmersMarkets_Buffer to make a
single layer.
1. In ArcToolbox, open ‘Data Management Tools’, ‘General’, ‘Merge.’
2. Select FVMarkets_Buffer and FarmersMarkets_Buffer as your inputs.
3. Name the output dataset MarketsBuffer.
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4. Turn off the FVMarkets_Buffer and FarmersMarkets_Buffer layers in the
table of contents.

Erase
1. Open the Analysis Tools again and open the Overlay tools, then select Erase.
Look at the graphical description on the right of this pop-up. Note that areas
within your clip features will be erased.
2. Make sure that you still have features selected (highlighted) on
BerkeleyBlockGroups, as areas from these selected features will be included in
the output.
3. Choose BerkeleyBlockGroups as your input feature and MarketsBuffer as your
erase feature. Name the Output Feature Class ‘LowIncomeBlocks’. Leave the
other defaults.
4. Click ‘OK’.
5. Turn off the MarketsBuffer layer. Your new layer should show only low income
areas that are more than 800 meters from markets.
6. Clear your selected features by clicking on ‘Selection’ in the top toolbox and
clicking on ‘clear selected features’.
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Select By Location
1. Go to ‘Selection’ in the menu bar and choose ‘Select by Location’.
2. Choose to ‘select features from’ BerkeleyPublicSites that ‘are within a distance
of’ the features in LowIncomeBlocks and apply a buffer of 800 Meters.

3. Create a new layer from your selected features by right-clicking on
BerkeleyPublicSites, going to ‘Selection’ and choose ‘Create a layer from
selected features’.

Expert Opinion
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Since the city is asking you to choose these sites, we can’t let the GIS do all of the work.
Select five sites from the candidates based on their service areas and your knowledge of
the area. Which sites will best serve the community?
1. Go to Selection in the menu bar, choose Set Selectable Features and turn all of the
layers off except BerkeleyPublicSites Selection. This will prevent us from
accidentally selecting features from other layers.
2. Make sure that BerkeleyPublicSites Selection and UnderservedAreas are both
visible on your map.
3. Use the Select feature tool and click on all of the sites that you have chosen. Hold
the Shift key to select multiple features.
4. Right Click on Public sites and choose export data. Export the selected features as
ProposedSites.shp. Click ‘yes’ to add a new layer to your map.
5. Create 800 meter buffer around these areas using the steps described in the
previous buffer section.

Exporting Data
Most people do not have access to GIS, so we must consider how we will share our data
with others. This section will teach you how to export your data to another format while
emphasizing quality map design.

Print Layouts
1. Enter the Print Layout view by clicking on the symbol in the bottom left corner of
your map viewer:

2. Go to file and click on ‘Page and Print Setup…’. Change the Orientation to
landscape and click OK.
3. Choose the select elements tool and click on your map. The data frame should be
highlighted, allowing you to resize it. Resize the data frame that it fits on the page

4. Use the zoom tool to make your map fill its data frame (not fill the page).
5. Add a legend to your map by clicking on Insert and choose legend. Include the
following layers in your legend: BerkeleyBlockGroups, FarmersMarkets,
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BerkeleyFVMarkets, ProposedSitesBuffer, ProposedSites,
UnderservedAreas, and BerkleyLimits. Use the ‘>’ and ‘>>’ symbols to add
and remove items from your list. Click ‘Next’.
6. Delete the legend title. Click ‘Next’. Keep all other defaults, and click ‘Next’ on
the next dialogue boxes. Click ‘Finish’ when prompted.
7. Return to the Insert menu and choose scale bar. Choose a scale bar and click OK.
8. Add a title from the Insert menu. Type “Proposed Fruit and Vegetable Stand
Sites”. Change the font size using the tools at the bottom of ArcMap. Doubleclick on the text box to edit; you will need to split the text into a few lines to make
it fit as shown.
9. Rearrange all the elements so that they are easily readable.
10. Edit the names of the layers that are in your legend by going to each layer’s
properties and editing the layer name under the general tab. The new names
should be written as you would like them to appear on your map.

Export as PDF
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Since not everyone has access to GIS, it useful to export your maps in another format,
such as PDF.
1. Go to the file menu and choose ‘Export Map…’.
2. Name the file and use the drop down menu to save as type .pdf.
3. Find your file in Windows Explorer and open it.
4. Print the PDF file.

